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Lesson objectives

In this lesson you’ll learn how to install and set up QuickBooks Point of Sale. After 
completing this lesson, you’ll be able to do the following:

 Determine what information you need to gather before setting up

 Install QuickBooks POS in single-workstation, multi-workstation, and multi-store 
environments

 Install and configure to facilitate data exchanges with QuickBooks financial 
software

 Describe the significance of the Server workstation in networked and multi-store 
environments

 Register QuickBooks POS

 Decide whether or not to import information from QuickBooks or another point-
of-sale application

 Prepare a QuickBooks financial software company data file for exchange with 
QuickBooks POS

 Use the Setup Interview to configure the program

 Set company and workstation preferences

 Accomplish the tasks you need to get a client started using QuickBooks POS

Learning resources

The following is a list of additional resources that you might find useful in increasing 
your understanding of the content covered in this lesson.

 Webinar (recorded): Installing and setting up

 Learning Center tutorial: Setup instructions

 Learning Center tutorial: Complete Setup Interview

 Learning Center tutorial: Importing items from QuickBooks

 Learning Center tutorial: Importing and updating items from other sources

Understanding QuickBooks POS terminology

Use these terms to help familiarize yourself with QuickBooks POS before beginning an 
installation:

Company data/company file—The data file(s) that you create and work with in Point 
of Sale and in QuickBooks. In Point of Sale, your file is called company data and stores 
your Point of Sale information. In QuickBooks, your financial information is called a 
company file. Financial Exchange links the two files so that data can be shared.
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Server/client database—A database model used by Point of Sale, where one 
workstation (the Server) stores the company data which is accessed by all other 
workstations (Clients) running Point of Sale on the same network.

Server workstation—The workstation that holds your Point of Sale company data and 
the database applications that allow Point of Sale to work with the company data. You 
install to this workstation first in a multiple workstation configuration. Only the Server 
workstation can perform certain data-related activities, such as creating company data 
and exchanging information with QuickBooks. The Server workstation must be 
running for Client workstations to run QuickBooks POS. The Server doesn’t need to be 
running the POS software, but it does need to be turned on.

If you have only one workstation, then it is a Server workstation.

Client workstations—Additional workstations on a network that access the Server 
workstation to work with the Point of Sale company data. There may be up to nine client 
workstations in a networked installation (ten total, including the Server workstation). 

Financial exchange—The exchange of information between Point of Sale and 
QuickBooks, typically run as part of the End of Day procedure from the Point of Sale 
Server workstation. 

Account mappings—Refers to the “linking” instructions of various Point of Sale fields, 
payment types, or transaction information to the appropriate QuickBooks payment 
types. These mappings determine how Point of Sale data is posted to QuickBooks. 

Store exchange—The exchange of Point of Sale company data between the Server 
workstations at Headquarters and remote stores in a Pro Multi-Store configuration.

User license—An entitlement or license to use Point of Sale on one computer. Having 
multiple user licenses allows multiple computers (workstations) to access the Point of 
Sale company data at the same time.

Planning the installation

The list below outlines the recommended sequence for installing and configuring 
QuickBooks Point of Sale. You do not have to install in this sequence, but it is intended 
to help get up and running in the most efficient manner possible.

If you are upgrading from a previous version and not making significant changes in the 
configuration (e.g., not adding workstations, stores, or just beginning to use 
QuickBooks), review this section and then refer to “Upgrading from a previous version” 
on page 72.

New Pro Multi-Store Users: Before beginning, it is strongly recommended that you read 
Lesson 11, “Working with multiple stores.” When ready, return here and follow this 
procedure, starting at the Headquarters store.
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Note: All installations on a network must be the same level (i.e., Basic, Pro, or Pro 
Multi-Store) and version (i.e., 6.0) of Point of Sale.

To prepare for QuickBooks POS installation:
1 Plan for the installation.

 Make sure the client’s computer(s) meet the minimum system requirements

 Familiarize yourself with Point of Sale terminology

 Decide on a location for the Point of Sale Server workstation and review how 
Point of Sale network licensing works

 Collect the information needed for setup

 Review the hardware planning section in the QuickStart Guide

 Become familiar with in-product help and learning resources

2 Install QuickBooks financial software and configure your QuickBooks company 
file.

 Install QuickBooks, or confirm the existing installation meets one of the three 
configuration options (see “Choosing a multi-workstation setup for 
QuickBooks financial software” on page 60)

 Create the financial company file, if necessary

 Review the financial company file for necessary settings

If the client is a new or existing QuickBooks user and plans to integrate the two 
programs now, refer to Lesson 12, “Exchanging data.”

3 Install Point of Sale.

 Install Point of Sale on the Server workstation

 Install Point of Sale on Client workstations

 Review multi-workstation guidelines in the QuickStart Guide

 Connect to the company data on the Server workstation

 Merge license with Server workstations

4 Connect hardware.

 Do not connect hardware until prompted to do so by the Hardware Setup 
Wizard

 The Hardware Setup Wizard launches automatically to walk you through the 
process of connecting and configuring the hardware

 Hardware is set up and installed on each workstation independently using the 
hardware setup wizard

5 Create the Point of Sale company data file.

 Complete the Setup Interview to do the following:

- Configure basic program preferences and customize features

- Learn about and sign up for Merchant and Gift Card Services

- Establish the connection to QuickBooks software
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6 Complete essential getting started tasks.

 Complete the Point of Sale setup

 Import existing data

 Add departments, vendors, items, and customers

 Receive merchandise and print tags

Reviewing system requirements

Prior to an installation, it is important to verify that the software and hardware on the 
client’s machine(s) is compatible with Point of Sale.

If the client wants to integrate QuickBooks POS with other software packages, such as 
QuickBooks financial software or Microsoft Excel, verify that the versions of those other 
applications are compatible with the client’s version of QuickBooks POS.

Installing the proper networking software allows up to ten networked workstations to 
run Point of Sale simultaneously within a single store. In addition, the Pro Multi-Store 
level allows clients to manage up to ten stores, with centralized purchasing, inventory 
control, and reporting.

For detailed information about the minimum system requirements for a QuickBooks 
POS installation, refer to the QuickStart Guide.

Collecting necessary information before installing

As you configure Point of Sale, and optionally QuickBooks, you are asked to enter 
certain information about the company. This information is used to set up the company 
file in each program.

We suggest you have the following information available before beginning:

 Name and addresses, phone numbers, web sites, etc. for each store in the company

 Names, addresses, contact information, account numbers, balances, etc. for 
existing vendors, customers, and employees

 Existing department names

 Current on-hand counts, costs, and prices for existing inventory items

 Applicable sales tax rate(s) and the name of the agency to which they are paid

 Pro Multi-Store Users: The Point of Sale License Numbers, e-mail addresses, mapped 
drive path, or removable media information for the Server workstation at each store

Note: Point of Sale offers two ways to import existing customer, vendor, and item 
information: importing data from QuickBooks financial software and 
importing existing data in Excel or .csv format. Importing existing data can save 
many hours of tedious re-entry. 
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The first method, importing data from QuickBooks financial software, is 
discussed in Lesson 12, “Exchanging data.” For details about the second 
method, see “Using the Data Import wizard” on page 77.

Choosing a server workstation

If you have multiple workstations, you must decide which of the workstations should be 
made the Point of Sale Server workstation. 

The choice of a Server workstation is important, because:

 Only the Server workstation can perform the following Point of Sale tasks:

- Financial Exchange with QuickBooks

- Creation, conversion, or renaming of a Point of Sale company data file

- Online registration and synchronization of license information with Intuit 
servers

- Store Exchange of information (in a Pro Multi-Store configuration)

 The Server workstation stores the Point of Sale company data and the database 
access applications. All other workstations (Clients) access the company data on 
this workstation.

 The Server workstation can also perform all other Point of Sale tasks.

Ideally, the Server workstation is the fastest, most powerful computer with the largest 
hard drive, most memory (RAM), and equipped with a modem, Internet connection, or 
removable media devices for information exchange.

Server workstation considerations

Consider asking clients the following questions when deciding the location of the 
Server workstation:

 Where do you want your QuickBooks financial software installed? 

Only the Server workstation can run Financial Exchange with QuickBooks. 
Installation options with QuickBooks are discussed in the QuickStart Guide.

 Do you want your sales associates to have access to the Server workstation? 

 Do you have single or multiple user licenses for Point of Sale? 

The Server Workstation must always be running for any workstation on the network 
to access the POS data.

 Where do you have access to the Internet?

 Where do you want to perform the End of Day Z-Out?

Once the Server workstation is installed and the company data file has been created, 
each additional workstation within a store is then installed as a Client workstation and 
accesses the company data file over the network. Client computers have only the Point 
of Sale program files installed locally.



60

I n s t a l l i n g  a n d  s e t t i n g  u p

Choosing a multi-workstation setup for QuickBooks financial 
software

If you are installing both programs at the same time we strongly recommend that you 
install and configure the QuickBooks company file first.

If the client is already using QuickBooks and has a company file set up, review this 
section to ensure the installation location is suitable to exchange data with the Point of 
Sale Server workstation.

In a multi-workstation configuration, a client’s QuickBooks financial software can be 
installed in any of three ways:

 Scenario 1: QuickBooks financial software only on the QuickBooks POS Server 
workstation. This method provides the most efficient exchange of data on a 
network. This is the most commonly-used multi-workstation configuration.

 Scenario 2: QuickBooks financial software on another network computer, with a 
second instance installed on the QuickBooks POS Server workstation. This setup 
requires a peer-to-peer network and is possible even if your client has only a 
single-user license for QuickBooks financial software. This is the recommended 
configuration on a network when your client wants to use QuickBooks financial 
software on a different computer than the Point of Sale Server workstation.

 Scenario 3: QuickBooks financial software only on another network computer, 
using Remote Data Sharing (RDS) applications to communicate with the 
QuickBooks POS Server workstation. The RDS applications are included on the 
QuickBooks POS CD.

Note: RDS essentially allows QB financial software to exchange data with the 
QuickBooks POS program across a network. This configuration requires 
more technical expertise to set up and operate. Step-by-step instructions for 
how to install and set up included in Appendix E of the User’s Guide.

Installing the Server workstation

If the client has only one workstation in your store, then it must be installed as a Server 
workstation.

To install the server workstation:
1 Close all running programs, except Windows.

2 Put the Point of Sale CD into the CD-ROM drive.

The Install Wizard launches automatically. 

If it doesn’t, browse to the setup.exe file on the CD and double-click it to start the 
installation.
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3 Follow the on-screen prompts to install the program files to the computer:

 Enter the License and Product numbers from the CD holder or that you were 
given when you purchased Point of Sale. 

 Read and accept the license agreement.

 Select Server Workstation as the Installation Type. 

If you want to specify the installation path and other setup options, select 
Custom as the Installation Type and then select server in the Install Options 
window. Accept the default installation folder (recommended) or browse to an 
alternate location.

Note: Install to the local hard drive and not to a dedicated network server.

4 Follow the prompts to complete the installation.

Creating company data

The company data file stores the Point of Sale information. On startup, QuickBooks POS 
displays options for opening or creating a company data file.

To create the Point of Sale company data:
1 Launch Point of Sale.

2 Select the New Company File option.

3 Enter a unique name for the company data file.

4 Click OK.

If this is a multi-store installation, also enter the Store type (Headquarters or 
Remote) and the store number.

Note: Install only one Headquarters store.

5 When prompted, select a workstation number. 

Select “1” for the Server workstation.

6 Click OK to close the confirmation window.

Point of Sale creates the new company data file. This may take a few minutes.

Registering Point of Sale

QuickBooks POS prompts you to register the Point of Sale software each time you start 
the program until registration has been completed. The software must be registered or 
it will not function on the 31st day after installation.

To register Point of Sale:
1 From the Product Registration screen, click Register Now. 

If you are connected to the Internet, an online registration form displays.

2 If you are not connected to the Internet, the phone registration window is 
displayed. Dial the number listed to register.
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3 Follow the online prompts or the instructions provided by the phone agent to 
complete the registration.

You are encouraged to register promptly. Besides keeping the software functional, 
registration provides other valuable benefits including notification of Point of Sale 
updates, enhancements and fixes, and access to certain online features.

View the license and product numbers after registering by selecting About Point of Sale 
from the Help menu. You must provide these numbers if you contact Intuit for support, 
to purchase more user licenses, or to unlock to a higher level.

Licensing Point of Sale

When you purchased Point of Sale, you purchased one or more user licenses. One user 
license allows one computer to access the Point of Sale company file at a time. Multiple 
user licenses allow multiple networked computers to access the company file at the 
same time.

One license, multiple workstations

You can install Point of Sale on more than one networked computer with a single user 
license. However, only one of those computers will be able to use Point of Sale at any one 
time. Likewise, if you purchase two user licenses, you can install Point of Sale on more 
than two computers, but only two computers can work in the company file at one time, 
and so on.

Note: All installations on a network must be the same level of Point of Sale (i.e., Basic, 
Pro, or Pro Multi-Store).

Network licensing flexibility

This licensing structure provides a great deal of flexibility, especially if there are 
different computers in the store that are used for different tasks, but not necessarily at 
the same time.

For example, a workstation in the front of the store during business hours rings up sales 
and performs day-to-day transactions, while a networked back-office workstation is 
used in the evenings to create purchase orders and exchange data with QuickBooks 
financial software. 

In this example, only a single copy (with one user license) of Point of Sale is required. It 
would be installed on the back-office computer as the Server workstation and the front 
computer as a Client workstation, using the same license number. Either workstation 
can access QuickBooks POS, but only one at any given time.

This licensing structure allows you to:

 Use multiple workstations for sale lanes or specialized roles (purchasing, receiving, 
etc.)
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 Use a single user license that is accessible via multiple workstations, but only one at 
a time, or 

 Use multiple workstations at the same time provided multiple user licenses have 
been purchased

Server workstation “master” license

When you install your Server workstation, you are required to register that software 
license with Intuit. This license becomes the “master” license for the store and reflects 
the number of user licenses you have purchased.

If you install Client workstations using the same license number, any of the 
workstations can run QuickBooks POS, but simultaneous access is limited to the 
number of user licenses purchased.

The Server workstation functions as the licensing “manager” and must be running 
(though Point of Sale does not have to be open) for Client workstations to access the 
company data. When any workstation starts Point of Sale, it connects to the company 
file on the Server workstation, an available user license is allocated to it until it exits 
Point of Sale, at which time that user license becomes available to another workstation.

As the business grows and it is necessary to add more workstations using Point of Sale at 
the same time, purchase additional user licenses, up to a total of ten per store: one Server 
workstation and nine Client workstations. No matter how many user licenses are 
purchased, they all share one “master license” (the license registered from the Server 
workstation).

Setting up hardware

The Hardware Setup Wizard is launched automatically on new installations to guide 
you through connecting and configuring hardware to work with Point of Sale. If you 
add hardware in the future, you can manually access the setup wizard from the File 
menu or from the hardware configuration pages in workstation preferences.

Note: Do not connect hardware to your computer until instructed to do so by the 
wizard.

If you are installing non-Intuit hardware, the wizard may prompt you to use the 
manufacturer’s CD or instructions to install the device. When finished, return to the 
Setup wizard and continue.

If you have multiple workstations, the Hardware Setup Wizard is launched 
automatically or can be run manually from each workstation. Optionally, hardware can 
be set up in Workstation preferences. (From the Edit menu, select Preferences, and then 
choose Workstation. Select the hardware type from the preference list.) 
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A complete list of QuickBooks POS equipment compatible with Point of Sale is provided 
in Appendix C of the User’s Guide. For more information regarding hardware 
configuration and troubleshooting, search the in-program Help index for Hardware.

Troubleshooting hardware

The Hardware Troubleshooter is launched automatically when an error condition is 
detected with the hardware. You can also launch the wizard manually from the Help 
menu at any time to troubleshoot hardware issues you may be experiencing.

Completing the Setup Interview

The Setup Interview launches automatically to assist you in configuring the program by 
asking a series of questions.

The information you provide in the interview is used to set up basic program options, 
customize features, and set up hardware. Also, there is an option to sign up for the 
QuickBooks POS Merchant and Gift Card Services, and integrate QuickBooks POS with 
QuickBooks financial software.

To access the Setup Interview:
 Select Setup Interview from the File menu.

As you complete the interview, keep in mind:

 If you are not prepared to complete a section, skip that section until later.
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 You can return to the Interview at any time to change most choices.

 The program settings configured during the Interview can also be reviewed or 
revised later by accessing company or workstation preferences from the Edit menu. 
The preference windows are also where you can set up more advanced options that 
are not covered in the interview.

 For more information on a particular topic, select from the blue help links available 
on each page.

Your Company

Enter the company name and contact information. This information is printed on 
documents created in QuickBooks Point of Sale.

If you specify the type of retail business the client operates, Point of Sale creates a set of 
merchandise departments suitable for the business, saving you some setup time. Later, 
you can add, rename, or delete the default departments to better fit the client’s needs.

For Pro-level users, Point of Sale also creates some standard inventory style templates 
based on the business type.

Other Stores

This section applies to Pro Multi-Store users only, and is covered in detail in Lesson 11, 
“Working with multiple stores.”

Customize Features

Use this page to remove Point of Sale features that your client does not plan to use. 
Clearing the checkbox for a feature removes the menu options, fields, and windows for 
that feature throughout the program, leaving the work screen less cluttered and more 
efficient for the activities important to your client. Read an explanation of each feature 
listed by selecting More Info to the right of the feature.

Sales Tax

If the client charges sales tax, enter the sales tax rate and the agency to which tax 
payments are made. If the client needs to collect different tax rates based on the type of 
merchandise being sold or where the customer lives, enter the rate charged most often 
and then later, after completing the interview, set up other tax rates and advanced 
options in Company preferences.

QuickBooks POS Merchant Service/Gift Card Service

Use the links on these pages to learn about and sign up for an account with either or 
both the QuickBooks POS Merchant Service and the QuickBooks POS Gift Card Service, 
both provided by Innovative Merchant Solutions, LLC (IMS), an Intuit company.
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Integrating these services means that credit, debit, and gift card sales can be processed, 
settled, and reported from Point of Sale.

Refer to the QuickStart Guide for more information about entering the account number 
in Point of Sale company preferences, setting up communications, and setting other 
service options.

Use with QuickBooks

Specify on this page if you are going to integrate with QuickBooks and, if ready to begin 
sharing data, you can establish the connection between the programs.

To connect with QuickBooks during the Setup Interview: 
1 Leaving the Point of Sale interview open, launch QuickBooks and open the 

financial company file.

Sign in as an Administrator or as a user with full Administrator rights.

2 Switch back to Point of Sale.

3 Select Yes and click Run QuickBooks Connection Wizard.

4 Follow the prompts to complete the connection.

You are now ready to send data between the two programs. Point of Sale reconnects to 
this same company file any time it is needed.

Interview Complete

The Interview Complete page appears when the interview is finished and you are ready 
to begin using Point of Sale on the Server workstation. It also has links to helpful getting 
started information and learning tools. 

Setting up sales tax

If your client charges sales tax, you can set up a sales tax structure in Point of Sale so that 
sales taxes are automatically collected on sales of taxable merchandise.

Point of Sale sales tax features include:

 Sales tax codes to collect sales tax based on the type of merchandise being sold. You 
can set up an unlimited number of sales tax codes and assign them to your 
inventory items. Within your tax codes, you set up tax options:

- Single tax rate for all items assigned this code

- Multiple tax rates to collect taxes for multiple agencies

- Price-dependent taxes which can be used with single or multiple tax rates, to 
collect taxes based on item price thresholds
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 Sales tax locations to apply different taxing instructions for your tax codes based 
on where or to whom the items are sold, such as for sales to out-of-state customers 
or to collect different tax rates for stores located in different areas.

 Customer tax flags to automatically collect tax on sales to a specific customer based 
on the tax location or tax-exempt status identified on the customer’s record.

 Changing tax codes or locations at time of sale to meet special tax circumstances.

 Collecting tax on shipping charges to meet local requirements.

 Sales tax reports to report on sales tax collected.

As you complete the Setup Interview, you are asked to enter your primary sales tax rate 
and the agency to whom you pay the sales taxes collected. Based on this information, 
Point of Sale creates two default sales tax codes (one taxable and one non-taxable) for a 
single tax location, identified as Local Sales Tax. If the situation requires additional 
taxing flexibility, you can add, delete, or edit sales tax codes or locations in company 
preferences at any time.

When a sale is made, sales tax is automatically calculated and added to all taxable items 
according to the tax structure. The item tax code identifies an item as taxable or 
non-taxable, but the sales tax locations, rates, and price thresholds that are defined in 
Point of Sale determine the amount of tax collected on each sale.

Note: In order to post sales tax properly in QuickBooks financial software, 
corresponding tax items and tax codes must exist in the financial software. 
Point of Sale automatically maps taxes to these tax items, groups, and codes in 
the financial software if they already exist (based on tax rate and tax agency) or 
creates these items in the financial software if they do not already exist. You 
may also create and map Point of Sale taxes to the QuickBooks financial 
software tax items you prefer.

Understanding tax codes and locations

Sales tax codes identify the tax status of items in inventory, such as taxable and non-
taxable, and the specific taxing instructions for those items.

In some cases, the retailer may be required to tax different item categories differently, to 
collect tax for more than one taxing agency, or to collect tax based on item price 
thresholds. In these cases, set up separate tax codes to meet these various requirements 
and then assign them to applicable items in inventory.

Once created, a tax code is available in every tax location in Point of Sale, and if needed, 
you can apply a different tax rate and other taxing options to each location by editing 
the tax code for that location.
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Multiple sales tax locations can optionally be used to define the specific taxing 
instructions for each tax code in different geographical areas or for customers requiring 
special tax handling. Sales tax locations work in conjunction with tax codes to apply the 
correct tax to sales transactions based on geographic location or special tax handling 
needs.

One default location, called Local Sales Taxes, is entered automatically by Point of Sale; 
there must be at least one tax location. The default location cannot be deleted unless 
new locations are entered. Add as many tax locations as needed.

Refer to Chapter 25 of the User’s Guide for more detailed information and examples on 
setting up, configuring, and applying sales tax codes and locations.

Installing client workstations

Point of Sale can be networked to allow up to ten workstations concurrent access to the 
company data within a store; one Server workstation and up to nine Client 
workstations.

The following general guidelines apply to multi-workstation configurations of Point of 
Sale:

 Only one Server workstation may be installed on a network

 The Server workstation must always be running (but not necessarily running 
QuickBooks POS)

 Each workstation must have the same version and level of Point of Sale

 If multiple workstations will concurrently run Point of Sale, each must have a 
separate user license (all user licenses are merged)

 Client workstations hold only program files, they access the Point of Sale company 
data on the Server workstation to complete program tasks

 Certain activities are not allowed on Client workstations:

- Creation of Point of Sale company data

- Financial Exchange with QuickBooks

- Store Exchange with other stores (in a Pro Multi-Store installation)

- Connecting to Intuit servers online to manage licensing 

To install a Client workstation:
1 Close all running programs, except Windows, on the Client computer.

2 Insert the Point of Sale CD into the CD-ROM drive.

The install Wizard launches automatically (if it doesn’t, browse to the setup.exe file 
on the CD and double-click it to start the installation).
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3 Follow the on-screen prompts to install the program files to the Client workstation:

 Enter the license and product numbers.

Use the unique numbers from the Point of Sale CD purchased for the 
workstation, or the same numbers used at the Server workstation.

The client will only be able to run Point of Sale at the same time as the Server 
workstation if you have purchased multiple user licenses and enter the client’s 
unique license number. In this case, it is important that the Server workstation 
not be running POS while the client is being installed.

 Select Add Client Workstation as the installation type.

If you mistakenly choose Server as the installation type, you must uninstall and 
reinstall as a Client. Only one Server workstation is allowed on a network.

 Accept the default installation folder (recommended) or browse and enter an 
alternate folder name on this workstation.

Do not browse to the server’s installation folder over the network.

4 Follow the prompts to complete the installation.

5 Repeat this procedure for each client workstation.

Note: Install only one Client workstation at a time. During installation, Point of 
Sale must be able to determine the other workstations installed and allow you to 
assign available workstation numbers. If more than one installation is running 
simultaneously on a network, both installing computers may assign the same 
workstation number. This could cause data conflicts and require reinstallation 
to correct.

Connecting to the company data

Once Point of Sale is installed on a Client workstation, the workstation must be 
connected to the Server workstation and the company data file.

To connect to the company data on the Server workstation:
1 Ensure that the Server workstation is running. (Point of Sale does not have to be 

running.)

2 Launch Point of Sale on the Client workstation.

QuickBooks POS searches the network, locates the company data on the Server 
workstation, and connects automatically.

If more than one QuickBooks POS company data file exists on the network, a listing 
of the files displays. Select the correct file and click OK.

3 Select a workstation number for this computer when prompted.

4 Use the Hardware Setup Wizard to install any hardware connected to this 
workstation.

See “Setting up sales tax” on page 66.
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Note: If you are installing several workstations with unique license numbers and they 
don’t have an Internet connection, we recommend that you install them all to 
the point just before connecting to the company data before beginning the 
license merging process. You can register, merge, and synchronize all of the 
workstations in a single phone call. 

Troubleshooting company data connection problems

Under certain circumstances, such as when the Server workstation is not turned on or 
when a firewall is enabled on the system, Point of Sale may not be able to automatically 
detect the company data file on the network.

If this occurs, the Database Connection wizard launches to assist you in identifying the 
problem and resolving it. If the issue is related to a firewall blocking access, refer to the 
QuickStart Guide for more information.

Merging licenses

If you purchase and install additional copies of Point of Sale with different license 
numbers on Client workstations, you must merge them with the Server workstation's 
store license. After merging, the new workstation shares the same license as the Server 
workstation and the Client workstation’s original license number is deactivated.

The Server workstation, in turn, synchronizes its license information with Intuit's 
licensing servers to reflect the fact that an additional user license has been added. The 
new user license is not available for use until synchronization is completed. QuickBooks 
Point of Sale prompts you to synchronize when needed.

If you entered an unique license number for the Client (different from the Servers), you 
must merge and synchronize within 30 days. If not, POS will still run on the client but 
only if the Server is not running POS (i.e., only one workstation will be able to access the 
company data until merging/synchronizing is completed).

To merge licenses:
1 From the prompt displayed, click Merge Now.

 If you are connected to the Internet, the merge happens automatically online. 
Click Finish when the process is completed.

 If you are not connected to the Internet, the phone merge window is displayed. 
Call the telephone number shown.

2 Follow the on-screen or phone agent instructions to complete the merge on the 
Client workstation.

3 To complete the merge and make the additional user license available, the Server 
workstation must synchronize its license with Intuit's licensing servers.

 If the Server workstation is connected to the Internet and has previously 
registered, this is immediate and automatic.
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 If the Server workstation is not connected to the Internet or has not yet 
registered, see the “Add Workstations” page of the QuickStart Guide for the 
proper instructions to merge/synch.

Note: The original license number of the Client workstation is deactivated after 
merging. It now shares a license number with the Server workstation.

You are encouraged to synchronize your license immediately from the Server 
workstation. Once the licenses have been merged, the number of user licenses available 
for the company file is not updated until synchronization is completed. If you had only 
one previous license, only one workstation can access the company file at a time until 
synchronization is completed.

If installing several workstations at one time and they are not connected to the Internet, 
you might want to get all of them to the point of merging before calling Intuit to 
complete the merge. Typically, several merges and synchronization of the Server 
workstation can be handled with a single call. The phone agent will guide you through 
this process.

Managing licenses

The Manage My License area allows you to view and print the Point of Sale license 
agreement, purchase additional user licenses, and to synchronize your in-product 
license information with the license data Intuit has stored for you. The latter could 
become necessary if you have installed Point of Sale on new computers.

To purchase additional user licenses:
1 From the Help menu on the Server workstation, select Manage My License, then 

choose Buy Additional User License.

2 Click Next on the window displayed to complete your purchase online.

OR

Click Skip online and purchase additional license by phone.

3 Follow the on-screen prompts to purchase the additional license.

4 If purchasing by phone, enter the validation code given you by the operator and 
click Next.

To manually synchronize licenses from the Server workstation:
1 Connect to the Internet on the Server workstation.

2 From the Help menu, select Manage My License. 

3 Select Sync License Data Online and follow the prompts.

You must have an active Internet connection for this option. If you don’t have an 
Internet connection, select the Purchase Additional User License option as described 
above, access the phone option, and tell the operator you are calling to synchronize 
your license.
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Exceeding the number of user licenses

If more workstations try to access the Point of Sale company data than you have user 
licenses, a warning dialog is displayed. The options in this case are:

 Close Point of Sale on another workstation, so a user license is made available to 
you.

 Synchronize licensing with Intuit, if you have just installed and merged a new 
license but have not synchronized yet as explained above.

 Buy additional user licenses so additional workstations can connect and use Point 
of Sale at the same time.

Upgrading from a previous version

The installation of Point of Sale 6.0 does not overwrite previous versions of the software 
and the existing data remains intact. You can return to the previous version later if you 
wish, but all transactions entered in Point of Sale 6.0 must be re-entered in the previous 
version if you choose to do so.

Installing the upgrade requires that the previous version is still installed or that you 
insert the previous-version CD when prompted. If you cannot locate the CD from the 
previous version, contact Point of Sale Customer Support.

Preparing to upgrade

Before you begin the upgrade process for Point of Sale, review the following:

 Review the QuickStart Guide to learn about new minimum system requirements, the 
Server/Client database structure, and licensing changes for Point of Sale 6.0

 Complete activities in the previous version:

- Settle all unsettled credit and debit card transactions

- Multi-store users, conduct Store Exchanges so data is uniform among stores

- Conduct a Financial Exchange with QuickBooks

- Make a backup of the Point of Sale company data

 If password logins are required to use Point of Sale, make sure there is a password 
assigned for the Sysadmin user and that this user can access the Employees and 
Security area.

Once upgraded to Point of Sale 6.0, only the Sysadmin user is allowed to add or 
delete employees, change other employee’s passwords, or turn on/off the login 
requirement.

 Do not un-install the previous version before upgrading.

If the previous version was uninstalled, either reinstall or insert the CD from the 
previous version when prompted. To install to a new computer, the CD from the 
previous version must be inserted during the installation process.
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 If making changes in the workstation configuration in conjunction with 
upgrading, such as going from one workstation to multiple workstations, adding 
additional stores, or just starting to use QuickBooks financial software, read and 
follow the instructions in the QuickStart Guide related to those changes.

Managing firewalls during upgrade

Point of Sale 6.0 uses Transmission Control Protocol/Internet Protocol (TCP/IP) for 
communication between workstations and the company data, and for certain activities 
that require communication across the Internet. Firewalls, including the firewall 
included with Windows XP, may block this communication.

Typically, a message appears from the firewall indicating it has detected a threat and 
asks what you want to do about it. Select the option to allow access always. This should 
prevent this message in the future. In the case of the Windows XP firewall, Point of Sale 
prompts you to allow automatic configuration. We strongly recommend that you allow 
the automatic configuration.

Several major firewalls applications are updated regularly with the latest Point of Sale 
file and port information and will automatically allow access to the ports and files 
needed. Use your firewall application’s instructions to be sure you have the most recent 
updates.

If you continue receiving firewall messages, it may be necessary to manually configure 
the firewall to allow access to the required files and ports.

Refer to the QuickStart Guide for additional assistance.

Upgrading the Server workstation

Upgrade the Server workstation first and then upgrade any additional Client 
workstations.

To upgrade the Server workstation:
1 Close all running programs, except Windows, on the Server workstation.

2 Close Point of Sale on all other workstations.

3 Put the Point of Sale Upgrade CD into the CD-ROM drive.

If the installation wizard does not launch automatically, browse to the setup.exe file 
on the CD and double-click it to begin the installation. 

4 Follow the on-screen prompts to install the program files: 

 Enter the License and Product Numbers provided with your upgrade CD.

 Read and accept the license agreement.
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 Select Server workstation as the installation type.

If you want to specify the installation path and other setup options, select Custom 
as the Installation Type and then select server in the Install Options window. Accept 
the default installation folder (recommended) or browse to an alternate location. 

5 If prompted, restart the computer when the installation is completed.

Converting company data to Point of Sale 6.0

All networked workstations must have the same version (6.0) and level (Basic, Pro, or Pro 
Multi-Store) of the Point of Sale software.

Once the company data on the Server workstation is converted to Point of Sale 6.0, 
workstations with an older version will no longer be able to access it.

To convert company data to Point of Sale 6.0:
1 Launch Point of Sale 6.0.

QuickBooks POS detects the previous version and prompts to convert it for use with 
the new version.

2 Click Yes to copy and convert the data.

3 Enter the new name for the company file (it can be the same as the previous name).

4 Select the location for the previous company file.

5 Log in to Point of Sale.

6 Register the upgraded software.

7 Synch the license data by selecting Manage My License from the Help menu, then 
choosing Synch License Data Online.

Note: Synching the license data is necessary to update the company file with the 
number of user licenses that were purchased.

Upgrading Client workstations

Upgrade only one Client workstation at a time. During installation, Point of Sale must 
be able to determine the other workstations installed and allow you to assign available 
workstation numbers.

If more than one installation is running simultaneously on a network, both installing 
computers may assign the same workstation number. This could cause data conflicts 
and require reinstallation to correct.

To upgrade Client workstations:
1 Close QuickBooks POS on the Server workstation, but leave the Server workstation 

running.

2 Follow the same upgrade procedure for the Server workstation to install the upgrade 
to each client workstation, but select Client Workstation as the installation type.
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3 Restart the Client workstation and launch Point of Sale 6.0.

4 Launch Point of Sale on the Client workstation.

QuickBooks POS searches the network, locates the company data on the Server 
workstation, and connects automatically.

If more than one QuickBooks POS company data file exists on the network, a listing 
of the files displays. Select the correct file and click OK.

5 If prompted, enter a workstation number and then your user name and password to 
log on.

6 If prompted, follow the on-screen instructions to merge licenses with the Server 
workstation.

See “Merging licenses” on page 70 for more information.

7 Repeat this procedure for each of your client workstations.

Note: Under certain circumstances, such as when the Server workstation is not turned 
on or when a firewall is enabled on the system, Point of Sale may not be able to 
automatically detect the company data file on the network. Review the 
QuickStart Guide or search in-product Help for more information.

Completing the upgrade

Once the upgrade installation is complete and the data is converted for use with Point 
of Sale 6.0, it is recommended that you review your QuickBooks POS and store exchange 
settings to make sure they are correct.

Reviewing Point of Sale settings

Due to the implementation of new features, data fields, and screen layouts, certain 
customizations and selections made in previous versions of Point of Sale are reset to 
default values when upgrading. If upgrading from Version 4 or Version 5 most settings 
will remain intact.

To be sure that the client’s system will continue to work as it did in previous version, 
review and configure the following settings as appropriate:

 Review and reconfigure list column layouts.

Point of Sale 6.0 allows you to add or remove columns to suit your business. 
Right-click a column header and choose Customize Columns.

 Re-enter memorized report layouts and filter criteria, if necessary.

Reports in QuickBooks POS support QuickZoom data drill-downs.

 Review and edit custom security groups, if applicable.

Employees assigned to custom groups do not have access to new features until you 
update the group rights to include those features, as appropriate. (Refer to “Working 
with employees ” on page 406 for more information.)
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 Verify the QuickBooks Integrated Applications preferences allow automatic login. 
Refer to Chapter 29 of the User’s Guide for more information.

 Verify the setting for vendor billing information. See “Verifying vendor billing 
settings” below for more information.

All other program preferences, user names, passwords, and prior security rights are 
transferred from the previous version to Point of Sale 6.0.

Verifying vendor billing settings

Vendor billing information, such as Invoice #, terms, bill and due dates, etc. for 
merchandise purchases may be entered in either Point of Sale or in QuickBooks 
financial software. The setting that determines if the vendor billing fields are on the 
Point of Sale voucher form is located in Company preferences.

When upgrading, these settings may change depending on which version from which 
your client is upgrading.

Default settings are:

 New Point of Sale user—Vendor billing fields are not on the Point of Sale voucher 
form. Enter billing information in QuickBooks financial software. Change this 
setting if you do not use QuickBooks financial software or if you prefer entering the 
information in Point of Sale.

 Upgraders from Point of Sale 5.0—Settings are retained from Version 5.0.

 Upgraders from Point of Sale 4.0 or earlier—Vendor billing fields are on the 
voucher form. Enter billing information in Point of Sale, which is then sent to 
QuickBooks with the vouchers during routine Financial Exchanges. Change this 
setting at your discretion.
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Updating store exchange settings

Store Exchange settings are copied from the previous Pro Multi-Store version of Point of 
Sale; however, in order for Store Exchange to continue functioning, these settings must 
be updated to reflect the new 6.0 file paths and new license numbers for the Server 
workstations at each store.

To update Store Exchange settings:
1 From the Edit menu, select Preferences, and then choose Company.

2 Select Multi-store, and then choose Store Exchange from the left-side menu.

3 Enter the new license numbers, transfer paths, and “In” folders as applicable. 

The “In” folder can be quickly set to the default location by selecting the default 
button or you can specify a custom path.

4 Click Save.

Note: If using direct file transfer for Store Exchange, remote stores should not all set 
their “In” folder to the same location on a network. When a remote store 
finishes processing a mailbag from Headquarters on a network drive, it deletes 
the mailbag file. If Headquarters were to send a mailbag file to a single network 
folder, the first remote store to process it would then delete the file, leaving no 
file for the other stores to access. Each remote should specify a separate In folder 
location, and Headquarters should send a separate file to each.

Using the Data Import wizard

The Data Import wizard is designed to relieve you of the time-consuming task of 
manually entering large amounts of existing data into Point of Sale.
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The wizard takes customer, vendor, or item information entered into a Microsoft Excel® 
spreadsheet or a comma-delimited text file and transfers this information into the 
corresponding data fields in Point of Sale.

The wizard can be used to import data from various sources:

 A pre-defined Excel import template in Point of Sale

 An existing Excel spreadsheet or comma-delimited text file

 Data exported from another point-of-sale software

 Data provided by vendors, such as catalog information for new inventory items or 
updates to existing items

When using the client’s own import file, you have complete control over how the 
import fields are mapped to the Point of Sale data fields. 

More information on the specific use of the Import wizard is provided in the 
pre-defined import template. You can also access additional information by pressing 
the F1 key to access online help while in the wizard.

To start the import wizard:
 From the File menu, select Utilities, then choose Import.

Using the Data Import log

The Data Import Log provides a way for you to review the results of an import operation 
and to identify errors and items that were not imported.
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To access the Data Import log:
1 From the File menu, select Utilities, then choose View Data Import Log.

2 Select a date, and optionally time, from the Available Logs column on the left. 

You have the following options in the log:

The information for the selected import is shown in the window. 

 Select the Show Errors Only checkbox at the top of the window to make it easier 
to identify where errors occurred.

 Click a hyperlink in an entry, if available, to take you to the corresponding 
program area where you can review the record in question.

 Click Print to print the log.

3 When finished, click Close.

If you used the default template, we recommend that you also review the template to 
ensure that data was imported correctly (qb pos import template.xls in the QuickBooks 
Point of Sale 6.0 folder).

You may see the following flags on the Inventory sheet of the template file, depending 
on the item import option you chose prior to importing:

 XL Dup column—If the item is duplicated within the template file itself, the row 
number of the duplicate item is written in this column.

 QBPOS column—If the item is a duplicate of an item already in Point of Sale, then 
QBPOS is written in this column.

Setting Company and Workstation 
preferences

The preference settings are used to configure QuickBooks POS to work with point-of-
sale hardware and to customize many of the QuickBooks POS features to meet your 
clients’ needs. There are two types of preferences: Company and Workstation.

See Appendix A of the User’s Guide for more detailed information.

Setting Company preferences

Company preferences configure the settings and define the options that are shared by all 
QuickBooks POS workstations on a network. Editing and saving some Company 
preferences requires that all other open windows be closed.

To set Company preferences:
1 From the Edit menu, select Preferences, and then choose Company.

2 Click the preference area to edit from the list.

3 Edit the preference settings as necessary.
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4 Click Save. 

OR

Click Cancel to exit without saving changes.

Setting Workstation preferences

Workstation preferences define workstation-specific settings and options, including 
hardware setup and printer configurations.

To set Workstation preferences:
1 Close all open windows on the workstation.

2 From the Edit menu, select Preferences, and then choose Workstation.

3 Click the preference area to edit from the list.

4 Make changes as appropriate.

5 Click Save.

Setting Employee and Security preferences

QuickBooks Point of Sale allows clients to maintain employee contact information, 
designate employee security rights for access to program features, designate time 
tracking for hourly employees, and set up employee commission levels (Pro and Pro 
Multi-Store levels only).

The preference that requires employees to log in is set in Company preferences. 

More details about setting up employees and security rights are available in Lesson 10, 
“Reporting and customizing.”



                                                                                                

81

L E S S O N  3

On your own exercises

On your own exercises are designed to provide you with an opportunity to practice 
some of the tasks and procedures covered in the lessons. Try the procedures here to help 
familiarize yourself with the software.

Before you begin, see “Working in Practice Mode” on page 43 for more information 
about the exercises and accessing Practice Mode.

Note: Be sure you are working on practice company data in Practice Mode when 
completing these exercises.

To launch the Setup Interview:
1 Select Setup Interview from the File menu.

2 Click Next to page through the Interview screens and view the setup information 
for Al’s Sport Hut.

3 Click Finish.

To set Company preferences:
1 Close all open windows on the workstation.

2 From the Edit menu, select Preferences, and then choose Company.

3 Select Receiving from the list of preferences.

4 Select the Warn when receiving against PO past its Cancel Date checkbox.

5 Click Save.
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Review questions
1 Which statement is NOT true about the new licensing structure in QuickBooks 

Point of Sale Version 6.0?

a Point of Sale can be installed on any number of workstations with an unlimited 
number of simultaneous users

b After merging, networked stations share a single license

c The number of simultaneous users is controlled by the number of user licenses 
purchased

d QuickBooks POS supports up to 10 workstations with each workstation having 
its own unique workstation number

2 What does QuickBooks POS call the workstation that creates and stores the Point of 
Sale company data file?

_______________________________________

3 How many computers can access QuickBooks POS simultaneously in a single-store, 
multi-workstation environment?

_______________________________________

4 List three activities you can perform only on the computer designated as the Server 
workstation.

_______________________________________

_______________________________________

_______________________________________

5 True or False: You may use a dedicated network server to hold Point of Sale company 
data.

_______________________________________

6 Name four types of information that your client should have on hand prior to 
beginning the installation of QuickBooks POS.

_______________________________________

_______________________________________

_______________________________________

_______________________________________

7 True or False: You should delete the previous version of QuickBooks POS before 
installing the upgraded version.

_______________________________________

8 List two reasons why a newly-installed Client workstation may not be able to 
automatically detect the QuickBooks POS company data file on the network.

_______________________________________

_______________________________________
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9 True or False: The Remote Data Sharing option for information exchange with 
QuickBooks financial software does not require a second copy of the QuickBooks 
software to be installed on the Server workstation.

_______________________________________

10 True or False: In order to access the Point of Sale data file simultaneously, each 
workstation must have its own unique installed and registered copy of QuickBooks 
POS.

_______________________________________

11 Which of the following is true?

a Once the Setup Interview has been completed, you may not go back to it and 
make changes.

b The Server workstation should complete the Setup Interview first.

c The Setup Interview is accessed from the Edit menu.

d All of the above.

12 Which of the following should you define first when setting up inventory in 
QuickBooks POS (assuming you did not import items from QuickBooks financial 
software)?

a Inventory items

b Employees

c Departments

d Vendors

13 True or False: Point of Sale connects automatically to QuickBooks financial software 
during the Setup Interview.

_______________________________________

14 Which QuickBooks preference allows QuickBooks POS to access the QuickBooks 
company data file?

_______________________________________

15 In which of the following situations are inventory items transferred between 
QuickBooks and QuickBooks POS?

a During item import only

b During item import and during each routine financial exchange

c During routine financial exchanges only

16 List two good uses for the Data Import Wizard.

_______________________________________

_______________________________________

17 What are the two ways to import data using the Data Import Wizard?

_______________________________________

_______________________________________
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18 Under what circumstance would your client need to merge licenses in a 
multi-workstation environment?

_______________________________________

19 Which of the following are options for setting up hardware on a workstation?

a Hardware setup wizard

b Workstation preferences

c Company preferences

d Setup Interview

Answers to questions are located on the following page.
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Answer key
1 A

2 Server workstation

3 10

4 Use the data recovery feature (QuickBooks users)

Exchange data with QuickBooks financial software (QuickBooks users)

Run Store Exchange (in a multi-store configuration)

Creation or renaming of a QuickBooks POS company data file

Online exchange or updates to QuickBooks POS license information with Intuit 
servers

5 False

Do not use a dedicated network server to hold Point of Sale company data.

6 Name and address, phone numbers, web sites, etc. for each store (if multi-store)

Names, addresses, contact information, account numbers, balances, etc. for 
existing vendors, customers and employees

Current on-hand counts, costs and prices for existing inventory items

Applicable sales tax rate(s) and the name of the agency to which they are paid.

Online exchange or updates to QuickBooks POS license information with Intuit 
servers

For Pro/Multi-Store Users: The Point of Sale license numbers, e-mail addresses, 
mapped drive path or removable media information for the Server workstation at 
each store.

7 False. 

If it has been deleted, there are two options: either it must be reinstalled before the 
upgrade can be completed or the CD of the previous version must be available for 
use during the installation process.

8 The server workstation may not be turned on.

There may be a firewall on the network blocking communication.

9 True

10 False

The same copy of Point of Sale can be installed on multiple workstations; however, 
they won't be able to concurrently access the data. Client workstations never 
register, only the Server workstation does.

11 B

12 C

13 False

14 Integrated Applications

15 A
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16 Importing data that has been exported from other point-of-sale software

Importing data provided by vendors, such as catalog information for new inventory 
items or updates to existing items

17 Use the Default Template with pre-defined columns and rows

Use the Custom Mapping feature to import data from any Excel or comma 
delimited file

18 Multiple copies of Point of Sale on a network in one location must share a license 
number. If your client purchased multiple copies of Point of Sale directly from 
Intuit, a single license number that includes multiple user licenses is included.

However, if your client purchases additional copies of Point of Sale from a retail store 
or other source, the additional copies come with unique license numbers, which 
must be merged with the existing license number on your Server workstation 
within 30 days of installation.

19 A, B
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Notes

Use this section to keep a list of any questions you have as you’re working through the 
lesson. Keep this page nearby and ask the questions when you attend the live webinar 
sessions.
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